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1. Follow instructions carefully to avoid personal injury.
2. ���������	��
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������������������������
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3. Mounting the Chlorine System in an outdoor box, in areas with elevated 

temperatures, may cause damage to the system if the enclosure's internal 
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4. Do not alter product construction.
5. For use with clean fresh water only.
6. ���	����	�����������������������������������	�������
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personnel only.
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chlorine calibration and set up procedure.
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Step 10. Verify the inlet and drain ball valves are in the open position 
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1. Chlorine panel assembly
 a. Built-in pressure regulator 15 to 120 psi.
 b. 3/8 inch hose barb connectors.
B�� =��
	��)��������������������;%JB$%&�������A�����������	�����	
�
 a. 1 spare membrane cap
 b. 1 bottle of electrolyte solution
� 	�� =������������
���;�
��
����������A
 d. 1 syringe
%�� =��
	��)�
���G��������%JBLB#J&&�;=OW�&&=�O#OA�;%J#$%&J==I�JB=I�J%=���
��������A
#�� +
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	Q
��
 a. English panel assembly manual
 b. CD with multi-language manuals
� 	�� !
�������������
�
�
��
 d. Drill template
O�� =��
	��H����������	
�������X�������	��

6. Customer supplied
� 
�� %@<N������������
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�
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� ��� G����	�
���

Sensor access plugs 

$	������



3#$%&������������
������(�����

����(�����������������
������(���������
��������
��
I�
��J��J����	���������
����
�������
������
������
����������	�����������
���Q�����
����
�
�	��
���������
����
treatment applications.
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Connect to a water source and plug it in.
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sensors.
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for chlorine reading accuracy.
Y� Z
��������������������
�����������
�������������
	Q����]���
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��
Y� +��������������HZ+��#^����������	�������
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section.

Y� %J<$%&J%P������������
���������+
��
��;%J<$%&�&W&J%A
Y� %JB$%&������������	����������Z��	���
��+
��
��;%JB$%&�&W&A
Y� %JB$O&������������	�Z��	�����	��+
��
��;%JB$O&�&W&A
Y� %JBLB#��G@:*P�Z��	���
��+
��
��;%JBLB#�&W&A
Y� %JBLO&��G�Z��	�����	��+
��
��;%JBLO&�&W&A

165 mm 
��;$�O����A%&O����;=B����A

BO#����;=&����A
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B�
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Ø  7 mm 
;&�BL����A

25 mm 
;=�&����A

Ø  13 mm 
;&�OB����A

LW�%����;%�=B����A

���� ,	'���	
��

G
�
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�
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P�����	
����	��
���

�����������	�	��������
sensor electronics

%JB$O&JL�;=OW�&&=�$L&A

)����	�������	Q

Flow cell O-rings

Vent
Cap

Output conduits

Transmitter
%J<$%&J%P�;=OW�&&=�$L%A

!��������	������

Flow rate indicator

Flow range limits

Flow regulator with strainer

?���������

Drain port
;%@<���	������A

Sampling port

�G������� 
electronics

�%JBLO&JL�;=OW�&&=�$L=A

�G����	���
�
%JBLB#J&&�;=OW�&&=�O#OA

_��	Q�
��	����	������
;%@<���	������A

2000-3825*

_��	Q�
��	����	� 
2000-2525*

%@<N�G�����
��
2000-3804*

%@<N�X
����
��� 
4300-5225*

Chlorine electrode 
%JB$%&J^

z�����
	���
	���������"����
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Disc spring ;BL&&J&&&%Az

Spacer ring
(�
������������������

P�������������
���

P�������������
����������:J�����;�
���A

P�������������
����������:J�����;��
��A
)����	����:J������;#���������A

Flat washer

Flat washer*

���	��������;	����
��
����A

Knurled thumb nut ;=L&&JBO=BAz

Flow cell bolt ;B#W&J&OO#A

"����+�+�	��A	����������-�
"��' @����	�(
Flow cell nut 6
Flat washer 15
Disc spring 9
Knurled thumb nut 3
Flow cell bolt 6

Flow cell nut

Flat washer

)����	�����
	Q����	Q

*����
�������� 
;%J#$%&�%W=A
;=OW�&&=�$<WA

Flow Cell Rebuild Kit 
;%J#$%&�%W&A
;=OW�&&=�$<<A

���� /
'�
�����"+���	
���	
�K�$�
%�/���

zH�����	��
�
������
%J#$%&�%WB�;=OW�&&=�$W&A

3-4630.392
;=OW�&&=�$W&A
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Y� Mount the panel according to local electrical, building, and or plumbing codes and seismic 

��"����������
Y� The panel must be mounted vertically in an upright position.
Y� [��������$����;|����A�
�
�������	���������������������	��������������������������
�������
�����
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�
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�
�	�����������
���
�
�����������������	��������������
Y� Bright light can promote algae growth.
Y� Keep panel system electronics and enclosure away from dripping water.
Y� ?����������������������
����
����I�
�����
������	���������������������������������������
���������	��

�������	�����	��
�
�8���	��������������I���
����I�����	���
�
�
����

,
��
��'
����	��+	���������	����
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Input for
100-240 VAC

�����
�����8&/�	����
��������+��+�&/��
�
�����	
�

D&!="=B
��	���������(���'�	��%	��+�I
��&/�?
����������������	�N����

��A	����D	�	�����
��+����+
����(�P���	
�+�����
�����
��(.
,	��
������&/��
%�����I
���
���	���%	�	�������
�����

����
����8,/�"�����D	�	���/
�?���	
�

Y� ?����������������	���������
�����������������������=B����B#����������

�
���=&&����B#&����I�
��	����	��������
�
�
���
	Q�����������������������
�������������;)������%A�
�
�	����	��������������������	����������
;)������#A�

Y� ?�������������������������������������J
�����
�
		�����������������������
��
of the electrical box using the appropriate conduit adapters to maintain 
���������#^��
������;����������
���
������������������������
�
	��
����	����	�����A

Y� ������	�����	��	�������
Q����
��
�
��O�
���������
��������	��
�
��������
building installation.

Y� ?���
�������	��	�������
Q������	�����������������������"��������
�
��������
easy reach of the operator.

Y� +
�Q�����	��	�������
Q���
������
��	����	�����
���	�����������"��������

E
%��������(����'	����"+���	
���	
��
Terminal H
�� Description
8��&,Q Voltage adjustment �
��������������=&�\���������	��	Q�����

increases output voltage
,/��= Operation indicator ������]Z�������������������������
���

is on 
R8T�98 DC output terminals ��>�P���������������������
�

��>�H��
������������������
��
LT�= ?�����������
�� �		�����
���
���
�����������
����


�
����"���	����;=&&����B#&��������
�����A

�����
�����8&/�"�����D	�	���

Y� Open the electrical box by loosening the four corner screws of the front 
cover.

Y� ?�������������������������������������J
�����
�
		�����������������������
��
of the electrical box using the appropriate conduit adapters to maintain 
���������#^��
������;����������
���
������������������������
�
	��
����	����	�����A

Y� ?���
�����������������������������������������������
����������������
�������;)������BA��[��������=BJB$��!��	�������������

Y� *�	�����
�
����"�����������������
������L���J���

=��)K�!����������
�����
����������������L%&&JLOB#�;=OW�&&&�$<LA>
Y� [���=&JB#��!��	������������I�=&O���I����"���#�#���J���

$	������

�(���'�"�����E
%��

Y� The panel system is pre-wired with an auto switching power supply that 
����
��
�����=&&����B#&�����O&@$&�G��������

Y� !���������HZ����
���?I�%&&�����I�=&O��������
Y� ������	�����	��	�������
Q����
��
�
��=O�
���������
��������	��
�
��������

building installation.
Y� ?���
�������	��	�������
Q������	�����������������������"��������
�
��������

easy reach of the operator.
Y� +
�Q�����	��	�������
Q���
������
��	����	�����
���	�����������"��������

�#�� D	�	���"����

$	������

+
9

$	������

Part # 7300-0024 (159 001 693) shown. 
Actual power supply may differ from Figure 2.

Follow all local and government recommendations and methods for installation of 
electrical connections to and between the system and other devices.
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D&!="=B
��	���������(���'�	��%	��+�I
��&/�?
����������������	�N����

��A	����D	�	�����
��+����+
����(�P���	
�+�����
�����
��(. 
,	��
������&/��
%�����I
���
���	���%	�	�������
�����

D	�	���L�����L����+

Ground Z
���������
�����
	��#����B&���������	
���������
�
wire here to help eliminate possible noise.

]����= #����B&����]�����=
]����B #����B&����]�����B
Relay 1 *��
��:�������=
H� *��
��H���
���������
�;	���
	�A������
�J��������

C Common

H: *��
��H���
����:����;���	���
	�A������
�J��������


Relay 2 *��
��:�������B�;������
����
���
��*��
���=A

Follow all local and government recommendations and methods 
for installation of electrical connections to and between the 
system and other devices.

�������/
�����	
��
Y� [����������������	�������������
�����	Q�����������������

connections. Do not wire directly to the transmitter.
Y� *�	�����
�
����"�����������������
������L���J��
Y� �����������#����B&���������	
�������������
���	��
����
������

power or other high voltage wiring.
Y� *��������������
���
�������������;�����������������������
��A�

�������������
�����	Q����������	������������
	�������
���	��
connected. Replace the jumper if you later remove your loop 

���	���?����������������
���	�����	����	��
I�����������������
jumper wire from its two terminals.

Y� The panel system uses an active loop output wired to the 
��	�������������
�����	Q�

V� "I��
�����	����
���EL/T���������EL/W������	?��	�����

V� ���������'	�����'������?����N�'����%	���
���

��+�?	���
��%�(���
������+��
�L

����

PLC Terminals 

Channel 2
4 to 20 mA

Channel 1
4 to 20 mA

+
-

+
-

    1  2  3  4  5  6  7  8  9  10

+  -
+  -

NC   C   NO NC   C   NO 

LOOP  1

LOOP  2

GROUND

RELAY  1

RELAY  2

GND

EL/�+�������������
�����	
�

���#����B&���
 loop device

D	�	��������
����'&��

��+�?	��

Q�'����%	�����'
?�+

�#��� D	�	���������
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���������
��"��������	
�

Y� *������
����	
�����������
		�������������������8���	����;����BI�)������=A��G��
��������%JBLO&JL�;=OW�&&=�$L=A����%JB$O&JL 
;=OW�&&=�$L&A����	�����	���������
I�������������]�	®�	����	���������������������������	Q���������|J�����	������J	��	Q������?������
�������	���
���
	�������������������	Q���������|J�����	��	Q����������	Q��������	�����	�������
	���������	�
�����������	��	Q�������������
��	Q�
��?���
�������	��������
�����������������8���	����
�
������������Q�������������	���
��
���������������Q���������������8���	����

���]�	® Connection to Sensor Electronics

L
�A	���!	��L
�A	���!	��
L
�AL
�A

3-2724-00
;=OW�&&=�O#OA
�G����	���
�

%JB$%&J^
)�]����	���
�

3-2750-7
;=OW�&&=�$L=A
�G����	�����	��

3-2650-7
;=OW�&&=�$L&A
�����������	�Z��	�����	�



11#$%&������������
������(�����

IN
OUT

pH Cl

�����D�����$�
%

OK

$�
%�!���

����8����
���������������������
�������������8�
�����������������+����
�
�+
����
�Q�����������8���	���������8����
�����������
���
%&�B#����#O�%$�]@��;<����=B��
�@�A�

?���� Drain
;���
���������A

Sampling port 
;8������A

����� ���	���/
�����	
��

Y� [�������
����W�O����;%@<���A�?�����������
������
��
��������������������������
Use hose clamps.

8��?���
�	�	
��I
�������������+��
�'�������

=
��K Turn off inlet valve ���� when stopping 
�
����8����

Y� ����
�
�������������������������
���������
��
������8������
��������	�����
������������8���
������������8���	���������8���	���������
�
���
by gravity, not system pressure.

"�����@�	�A�!�������/
�����	
�

P�����
������
�����������������
����!
����8���
is automatically shut off when disconnected.

)���]���)����
����	
������;8����������
��=��
�@=O����AI�
����)����*����
����	
�����������
�
�
�����8���
adjusted using the Flow Cell ball valve. (=��)K The 
inlet hose barb will also need to be changed. Contact 
�
	���������
��
����A
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���� �����'	�����)+	�	���E�
��+���
Y� ����<$%&J%�;=OW�&&=�$$BA��
���������������������	
���
��\���]?X*��Z�
�
�:P�?:H(��
Y� ������]?X*��Z������
�������������	
����
���
�
������
������������I�
�����	�������������
�
��������
�����	������
Y� ����:P�?:H(������
����������������������������I�

�����
�
������	������������I���������
���
�
������

Step 1.   E�������+��
�+�����)=�)!�A�(K
 � Y�������
�+� to select the /&L"F!&�) menu.
� � Y�������
�+��to select the �E�"�=� menu.

Step 2. ��)���������~�(�/
+��
� � ����~�(�/
+��	����������A�(��	����P������
� � Y���������������������K�����
�I�����
����
�������������������������������������	��
������

Step 3.������
�������'����	�����

��%	���������
�������
%�A�(��

Step 4.   E�����������A�(��
������������'����	��'��
�����+	��+�
� � Y�����������
����
���������������������8
������

Step 5.���E�����������
����A�(���
��+	����������	������'����
� � Y��������Q���

�
�	�������8
��������������

Step 6. ��E���������)=�)!�A�(��
���?��������%�����	�����+���������
��������

P�����������
�
���Q����������
��������������
���
�����������8
�������������������	
��������
����
��
�
value of the item being edited and will return you 
to Step 3.

*�+�����)��
��
P�����������
�
���Q����������
��������
�����
saving the last setting to return to view menu.

$	�	���+�)+	�	���

�����:�'����8	�%�'��������
%���������
�����+�I�����+	����(��I�������'	������

FCl:  2.67 ppm
7.10 pH  25.3 °C

�����	�������I��G�
�
�������
������
���������������������
FCl = free chlorine.

Cl Raw:  103.8 nA
pH Raw:  -5.9 mV

���������;��A�
�
��G��
��;��A�����
���������������������
For reference only.

Loop 1   10.68 mA
Loop 2    8.56 mA View of current loop 1 and loop 2 output.

Last CAL:
10-18-10 View of the last calibration date. Editable in the Calibrate Menu.

����	
��""���#����/��
�	��������'	����

Y� The View Menu is displayed during normal operation.
Y� �������	��
��?Z!�
����
�I�����������[P�����:!H�
�����Q�������������	������������	��������
�	����������������������
���������
�������

view.
Y� ��
�����������?Z!�
����
��
�����������������������������
������
Y� H��Q���	�
�������	���
������	�
����
����
������	�����
Y� :���������������	
���������
���
�����������?Z!������
Y� ��������������J����
�����=&���������
�
����������������������������
�����
����
��
Y� !�����
������������]?X*��Z����:P�?:H(������I�������
�������������������������������J�
��
Y� � 
����
��
�����=&���������
�
�����������?Z!���������
�������=&���������������
	��������		����

C&<�"�=!
Y��� *��������������������������������������������������	����	������
Y��� )������������	������	
�����������
���
�������
������������

�
������������
���������

 1. ����8	�%�*
+�
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&����������/&L"F!&�)�*���K
������]?X*��Z�
�
�:P�?:H(���������"�����
�KZ���:�Z�
P�����
�
����
�����ZH�Z*�Q�������B���	��
�����
		��������
��]?X*��Z������

Step 1.ENTERENTER

2sENTERENTER

;G��
A

/&L"F!&�)�'���

5s �E�"�=��'����!

���� ):�'���K�/��	����	
�

ENTERENTER

Step 6.
ENTERENTER

)+	����������	������'���K
This is the edit mode.
�����������Q����	�
��������8
��������������
The ��Q���

�
�	�������8
�����������������
�	����������������
?���������
����I�����N]
����
�N�

����
��	�
���
������&WJ=<J&W�
to 10-18-09.
��������������	���������
���
	�����
�������
������
:��������8
��������������	
������
���
�

Step 5.

E�����)=�)!��
���?��������%�?�����
!���������
������������
�����
��
���I��������������ZH�Z*�Q���
������������
������������	����I��
Q�����������
�
�����
�
��
�������
����������	������
�
������������
	Q����(����%�

�)���������~�(�/
+�K
P�������������I��I��I���Q���������"���	������	Q������
����
� 

�
�������������������������
���
���?�����Q������������
�����O���������
����������
����
�������������NZ�����K�����
�NI�����������������������
�?Z!������

Step 2.

P�����������
�
���Q����������
��������������
���
�����������8
�������������������	
��������
����
��
�
value of the item being edited and return you to 
Step 3.

*�+�����)��
��
P�����������
�
���Q����������
��������
�����
saving the last setting to return to the View Menu.

$	�	���+�)+	�	���

Example

Step 3.
���
�������*���K
P����������������Q��������	�����������������+�����
Refer to pages 3 and 4 for complete listing of these items.
!���������������
�I����������������
�
���Q����������
��������
����������������
����
����������?Z!������
?�����Q������������
�����=&��������I�����
����
���������������������
�?Z!������

Step 4.
�����������	��'��
�����+	��+K
?���������
����I�N]
����
�N�;�
���	
����
�����

��A����	����������
����
P��������������Q�������	�����������������
�
�������������	�����
into edit mode.

Cl Zero
Calibration:    >  

CALIBRATE:----
Enter Key Code  

CALIBRATE:---
Enter Key Code

CALIBRATE:--
Enter Key Code

CALIBRATE:-
Enter Key Code

Cl Zero
Calibration:    > 

Last Cal:
   09-18-09   
Last Cal:
   19-18-09

Last Cal:
   19-18-09
Last Cal:
   10-18-09

Last Cal:
    Saving 
Last Cal:
   10-18-09

Last Cal:
    09-18-09    > 

Last Cal:
    09-18-09    > 
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  Cl Zero
Calibration:    >

!���������������
I��������������

�����
������������������
�������
����
��
I�����	
��������
�
���
�
�
�������
�����
�
������	�
�
�	
����
���������������!�������Z
���+�
�I����������Z�����
�����������
����
��
��
����
�������������������	���Z�
��������(�	�����=O�

Cl In Process
 Calibration:   > Z��������	����	���������
����
��������
������
��P�������Q���������Z�
��������(�	�����=O�

Cl Temperature
 Calibration:   >

Enter process temperature from a reference thermometer: °C or °F. Units are set up in the 
Options Menu. Example on Section 15.

Reset Cl to
Factory Cal:    >

This menu resets Cl readings, Zero Calibration 
�
�������
������
	Q����)
	������
����
������
!�*H?H���[����������
����	
����
���������������������������

pH Standard
Calibration:    >

(����G���������
����������
�������
�����
�����������������G���
����������
Example on Section 13.

pH Slope
Calibration:    >

��������
���������������G���
��������������������
�
���
�

�
��
������������
����
���B��G�
units apart. Example on Section 13.

Reset pH to
Factory Cal:    >

*������G���
�

�
I�����������
	Q����)
	������
����
�����
!�*H?H���[����������
��G�	
����
���������������������������

Chlorine Units:
     ppm        > ������������������	������������������������
���������������������@��

Loop 1 Source:
  Chlorine      > �������	������������G����������#����B&����	�������������Example on Section 16. 

Loop 1 Rng: ppm
  0.00   5.00  >

Select the minimum and maximum values for the current loop output. Units are derived from 
]����=�(���	���?������(���	��=����	�
���
I��������������J�
���������
���

Loop 2 Source:
    pH          > ��������G����	�����������������#����B&����	������������

Loop 2 Rng: pH
 00.0  14.00   >

Select the minimum and maximum values for the current loop output. Units are derived from 
]����B�(���	���?��(���	��B����	�
���
I��������������J�
���������
���

���� /��	������*����,�
�	�	
��

/��	������*����
Factory settings shown ,����	��	
�

/��������������$����	
��

=��)K
For greater accuracy it is recommended that the initial calibration of the system should be in the following order:
1. Temperature
2. �G����	���
��;���������
���G��������������	�
��
��?���
��
���G���������������	��
������������G��
�������������������������

���������	
����
���������	��������������A
3. Chlorine sensor
Y�
Y� ��������������
����
���+����	
������
���
��
����
�
�����
����
�
�I����������������
���
���
����
�
��������
��������������

]����
�
�*��
�����������
�������������������	
����8���	�������"�����������
Y� ���������
�
��G�	
����
������	������������������������������
��
��
�����������
���	��
�

The menus below are displayed here in the order seen when scrolling down through the Calibrate Menu.

=��)K�The next two pH calibration screens will be shown only when a valid pH sensor is detected.

P���������[����������������
Q�������	����������������������

P���������*�����������Q������������
edit mode

P���������Z�����Q�������
��������
settings

ENTERENTER

2sENTERENTER

;G��
A
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If Pulse Mode was chosen:

Relay 2 Mode:
      Off       >

�������*��
��B���
���������
����>�:��I�]��I�G���I�!��
��I����P������
To disable this relay choose Off.

Relay 2 Source:
     pH         >

��������G����	������������*��
��B�������������	�����
�
�
��������"�����*��
��B�
screens below do not appear if Relay 2 Mode is set to Off. 

Relay 2 Setpnt:
    0.00 pH     >

?��]������G����+�
�I�*��
��B���������
	���
��
�������������	������
	����������
�����
[����������
�������8�	��*��
��B�(���	��

Relay 2 Hys:
    0.20  pH    >

*��
��B���������
�
	���
��
�
��*��
��B�(����������������������������������
����
�������
G�������]���(������������	�����

Relay 2 Delay:
      0.0 secs  >

Set the time delay for Relay 2 to activate after reaching the Setpoint. 
Range: 0 to 6400 seconds.

If Low or High Mode was chosen:

Relay 1 Hys:
    0.20  ppm   > *��
��=���������
�
	���
��
�
��*
����������������������������������������

Relay 1 Delay:
    0.0  secs   > Set time delay for Relay 1 to activate after reaching the setpoints set in Relay 1 Range.

Relay1 Rng: ppm
  0.00  5.00   > Enter the range where Relay 1 will activate above and below this setpoint.

Relay1 PlsRate:
120 pulses/min  > Set the maximum pulse rate. Range: 1 to 400 pulses/min.

Relay 1 Mode:
    Off         >

���������
���������
����>�:��I�]��I�G���I�!��
��I����P������?��:��I�
��������"�����*��
��=�
functions are inactive and not visible. Example on Section 16.3.

Relay 1 Source:
     Chlorine   > �������	������������G�����*��
��=�

Relay 1 Source:
     Chlorine   > �������	������������G�����*��
��=��

Relay 1 Source:
     Chlorine   > �������	������������G�����*��
��=��

Relay 1 Setpnt:
    0.00 ppm    >

?��]������G��+�
�I�*��
��=���������
	���
��
�������������	������
	����������
�����
[����������
�������8�	��*��
��=�(���	���

Relay 1 Hys:
    0.20  ppm   >

*��
��=���������
�
	���
��
�
��*��
��=�(����������������������������������
����
�������
G�������]���(������������	�����

Relay 1 Delay:
      0.0  secs >

Set the time delay for Relay 1 to activate after reaching the Setpoint. 
Range: 0 to 6400 seconds.

!���(�$����	
��

If Low or High Mode was chosen:

If Window Mode was chosen:

Relay1 Rng: ppm
  0.00  5.00   > Enter the range where Relay 1 will activate above and below this setpoint.

Verify all relay settings if the Relay Source is changed.

�/��	������*�������
��	���+
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���	
���,	����(
;)
	�������������������A ,����	��	
�

���������	
���*����,�
�	�	
��

   Contrast:
       3        > �
���������]���	����
����������������������������������=����������	����
��I�O�����������

Cl Sensor Type:
    Free Cl     > Select the chlorine sensor: Free Cl.

   pH Input
     Sensor     >

�������+
��
�����(�������?��(���������	�����I������G��
�������������	����	��
��G����������������
���
���������+
��
�����������
��G��
�����
��
����������������������	����	��
�

Temp Display:
       °C       > Choose units of °C or °F.

   Averaging:
       Off      >

:))������������
������������������������	�
������]:!� �#�O���	��
�I�G?�G� �W���	��
�����
���
��
�
����������?�	��
���
���
�����������

������
����
��

Manual pH Value
    7.000 pH  Z�����������G��
������������
��G���������������	����	��
�

If Manual pH input was chosen:

Relay2 Rng: pH
  0.00  14.0   > Enter the range where Relay 2 will activate above and below this setpoint.

Relay2 PlsRate:
120 pulses/min  > Set the maximum pulse rate. Range: 1–400 pulses/min.

If Pulse Mode was chosen:

   Find New
    Sensor(s):  > *�"����
�����������
���������������	�
���
��������������������������������������H��

Last Cal
    10-18-09    > Edit the calibration date.

)�+�
I�/��	������*����

Relay 2 Rng: ppm
  0.00  5.00   > Enter the range where Relay 2 will activate above and below this setpoint.

Relay 2 Hys:
    0.20  ppm   > ��������
����������
�
	���
��
�
��*��
��B�*
��������������������������������

Relay 2 Delay:
      0.0  secs >

Set the time delay for Relay 2 to activate after reaching the setpoints set in the 
Relay 2 Range.

If Window Mode was chosen:

Relay 2 Source:
     pH         > ��������G����	������������*��
��B�

Relay 2 Source:
     pH         > ��������G����	������������*��
��B�

�/��	������*�������
��	���+

P���������*�����������Q���
to enter Edit Mode

P���������Z�����Q���
to save your settings

ENTERENTER
P���������[����������Q���
to scroll through the menus

5s �E�"�=��'���ENTERENTER

;G��
A
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����	
���*�������
��	���+

���	
���,	����(
;)
	�������������������A ,����	��	
�

Zero Cal: ppm&nA
 xxx.xx  xxxx.x ����������������
�¡�����
����
�����

�
��������
�
����

Temp at Cal:
     xxxx.x °C ������
�������	��
�
�
�����������?�JP��	�����
����
�����

pH at Cal:
     xxx.xx pH �G��
������	��
�
�
�����������?�JP��	�����
����
�����

In Proc: ppm&nA
 xxx.xx  xxxx.x ����������?�JP��	�����
����
������
�������������
��������
���������
����
���+����

Temp Offset:
     xxxx.x °C Temperature offset calculated from user entered temperature calibration from Calibrate Menu.

Elapsed Time:
   xxxxx.  hrs Total hours of operation.

Low & High: °C    
-xxxx.x   +xxxx.x ]������
�
���������������
���������������������
������������	��
����
����������
�����

Test Loop 1:   
                >

P�����[P�����:!H�Q��������
��
�����������
���	��������
���������%�$�������B=�&&������������
]����=��������

Test Loop 2:   
                >

P�����[P�����:!H�Q��������
��
�����������
���	��������
���������%�$�������B=�&&������������
]����B��������

Test Relay 1:   
                >

P�����[P�����:!H�Q��������
��
�����������*��
��=�:���
�
�:������������]Z�����������������
������
���������	�����������
�����

Test Relay 2:   
                >

P�����[P�����:!H�Q��������
��
�����������*��
��B�:���
�
�:�������������]Z������������������
������
���������	�����������
�����

Read Sens Data:   
      No       >

?��N�Z(N��������	��
���������������;!��+����(A��	��������������������
?��NH:N������������������
������:�������+����

Cl Sensor S/N:
   xxxxxxxxx View the sensor serial number.

Cl Type & Range:
 2630  xxx.x ppm ?
�����������	��������������������	����	��
�
�
����������
����

If Yes was chosen:

Loop 1 Adjust:   
      4.00 mA   >

�
�����������������	������������������]����=������
����
���
����������������������	����
	���������������*
���>�%�<&�������O�&&����

Loop 1 Adjust:
     20.00 mA   > �
������
������	������������������]����=��*
���>�=W�&&�������B=�&&����

Loop2 Adjust:   
     4.00 mA    > �
�����������������	������������������]����B��*
���>�%�<&�������O�&&����

Loop2 Adjust:   
    20.00 mA    > �
������
������	������������������]����B��*
���>�=W�&&�������B=�&&����

   Decimal:
    ***.**      > Select the decimal point for the display. Maximum of 2 decimal places.

)�+�
I����	
���*����
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��/��	����	
�

System Start-up: Step 3
If a pH sensor is part of the system, use the GF Calibration Kit 3-2700.395 (159 001 605) prior to initially installing the sensor and 
during its normal lifetime.  If a pH sensor is not available but pH determination is necessary, measure process pH with a separate 
test and enter the value in the Options Menu. Next step: Chlorine Sensor Conditioning (see section 6, page 19). 

View Menu

Calibrate Menu

FCl:  2.67 ppm
7.11 pH  25.3°C

pH Standard
Calibration:    >

ENTERENTER

2sENTERENTER

;G��
A

5X

pH Standard Cal:
07.00 pH/ 0 mV

�G���������
����
entered here

6

�

5

#

Step 4

) � & * E L )*��������������G���������
��
��

�����G�����������
��������	
����
��
�
�
���������
����������G�
��������������	������	
����
��������������;��
�

�
A�
�
��������
Z��	���
������������
���
���
����������&�������
��G�L��������
��BO�¢���
(�������������
��������������G�������
Y� ����
���Q����
����������
���	�����8���������	
����
�����

���� �H��II���������+��+�
������
�����������������������
����
�
������G����������������
connected.
1. ��������������
����8���������������������I�����������������

�G�����������������8���	����
2. [������G��������L�&I���
	����������G��������������
�

	��
��	
����
�����	��I��������
�����������G�	
����
�����Q���
%JBL&&�%WO�;=OW�&&=�$&OAI����	�����������������������	���
��

3. P����
�������
��
�������
�������	��
��	�������������������
electrode between buffers

4. *����������I���
	�������G����������������G�L�&��������
�
�

��������������

���������
�������

):�'���K������H�����+��+��
������

5. Go to the Calibrate Menu.
6. (	�����
������O��������������pH Standard menu.
7. P�����£����������Z
���+�
��
8. Z����������G��
��������������������
���������	���
�������
	�
�

in; �����in this case. 
9. P���������Z����������������
���������������
10. Z����������������+�������

���� �H���
��
1. *�����������G��������������������������������������
�
�������

it in distilled water.
2. P�
	�������G�����������
�
�������������������������;��
����>�

�G�#�&=A�������G���
�

�
�
�
���������������
����
���B��G�
units apart.

3. H���������G�
�
������

�����������������+����
�
�
��������
�����
�������

):�'���K������H���
����
������

4. (	�����
������=���������������H���
���menu.
5. P�����£����������Z
���+�
��
6. Z����������G��
��������������������
���������	���
�������
	�
�

in; 4.01 in this case. 
7. P���������Z����������������
����������������
8. Z����������������+��������

9. *���
	�������G���������
	Q����������8���	����
10. �������������
����8��I������G�������	
����
��������	��������

) � & * E L )

View Menu

Calibrate MenupH Slope
Calibration:    >

pH Slope Cal:
04.01 pH/ +177 mV

ENTERENTER

�G���������
����
entered here

4

6

5

) � & * E L )

) � & * E L )

=��)K������G�����������������	
����
����������������
������	��
��O&������������������
���������	���
�����	��	
�������
Z��	���
�>��G�#�&=� ���=LL���

pH Standard Cal:
07.00 pH/ 0 mV
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���� *�������H�/
'������	
�

?�������G��������
����	
����������
���I�����������G��������
����	
�����
can be entered manually and will be used to calculate the chlorine 
measurements.

):�'���K�/�����������H�	�����I�
'�����
���
�*��������+�������
���H�?�����
I������

1. Go to the Options Menu.
2. (	�����
������B���������������H�"�����menu.
3. P�����£����������Z
���+�
��
4. Choose *����� and press Enter.
5. (	�����
������=�������������*�������H�8�����menu.
6. P�����£����������Z
���+�
��
7. Z�����������������	�����G��
���>�����.
8. P���������Z����������������
���������������
9. Exit to the View Menu.

) � & * E L )

���� /��
�	�������
��/
�+	�	
�	��
System Start-up: Step 4
A new chlorine sensor or one that has had the electrolyte or membrane replaced must be conditioned to generate stable and 
accurate readings. To condition a chlorine sensor, the sensor and sensor electronics must be installed and powered and must 
��������	�
��	��
�
����������	��	�����	��
Next step: Calibrating Chlorine (see section 7, page 20).

pH Input
     Sensor     >

pH Input
     Manual     >

pH Input
Sensor  Manual

Manual pH Value
    7.220 pH 

Manual chosen

H����G��
����������


) � & * E L )

Options MenuStep 2

5

4

ENTERENTER

ENTERENTER

/��
�	�������
��/
�+	�	
�	��
1. ��������
�
�

������
����8����
�������
������
�����	�������������������#�����������
������������������
������
���	
������
	���������

���	�����������������B�������
2. K������8����
���#����B&����
���	���������
��
	��
��
��������
���	�����
��	����	�����������
���������

=��)K�The membrane cap must be replaced every time the electrolyte is changed.
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System Start-up: Step 5
Chlorine sensors need to be calibrated for accuracy. After the 4 hour conditioning period, Temperature Calibration, Zero Point 
�����������������������	����������������		�������	��	�����	�������������!��������	�����"��"���	���	�����"����	���
��	�
Next step: Setting Output Settings (see section 8, page 21).

���� J��
�E
	���/��	����	
�
The chlorine sensor needs to be calibrated against two chlorine 
�������	��>������	��������
�
��������	����	�������������	
�������������
point calibration is very stable. Calibration must be done with every 
new sensor and any time a membrane cap is replaced.

1. K������8����
���#����B&����
���	���������
��
	��
��
��������
devices that connect to the transmitter.

2. ��������������
����8���
�
������������������
�	���������������
with the electronics still attached.

3. P�
	��������������������
�������
��
����
4. !
���������������

������
�������I�������
�������	
����
������

Stirring the sensor in water is not necessary, but allows the 
����
�������
��������
�����

):�'���K���������J��
�E
	���/��	����	
����������&�

5.  Go to the Calibrate Menu.
6. �(	�����
����� one menu to the /��J��
�menu.
7. �P�����£����������Z
���+�
����������������8
����������������������

��

������������
�
�������������

�����	
����������
���
I�����
can only be saved as displayed.

8. �P���������Z������������
���������������

��������
���������������
or press           to escape without changes.

9.  Exit to the View Menu.

10. ������¡����P������
����
��������	�������I�����
	��������������
	Q�
���������8���	����
�
�����������
����8����
	Q����

11. !
�������������	����������

�������
���������	��
�
��I��������������

�	��������?�JP��	�����
����
�����

) � & * E L )

  Cl Zero:
Calibration     >

Zero Cal:  ppm&nA
    0.20 / 001.0

) � & * E L )

Calibrate Menu

ENTERENTER

]�������
��������
�����
Zero Cal.

Step 6

#

�����	�������?���+��	�����J��
�E
	���
/��	����	
��'�������������������&��
%���
���������"��E�
�����/��	����	
���
	���

���� /��
�	�������
����'���������/��	����	
�
The temperature element inside the chlorine sensor needs to be 
calibrated. Use a reference thermometer at the same temperature 
and in the same medium as the immersed sensor.

���>�*�����������G����	���
�����������8���	����
�
������������
�������	���������������?�����������
���G��������������������
I�
remove the cell plug to insert the thermometer. Replace the plug after 
TC Calibration.

):�'���K������������	�����+���'����������
�������/�

1. Go to the Calibrate Menu.
2. (	�����
����� 3 menus to the /����'���������menu.
3. P�����£����������Z
���+�
��
4. Enter the temperature reading. ):�'���K�����.
5. P���������Z����������������
���������������
6. Exit to the View Menu.

Step 2

4

 Cl Temperature
  Calibration:  >

Cl Temp:  Cal
  +025.3 °C

) � & * E L )

Calibrate Menu

H����������
���
ENTERENTER

) � & * E L )
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#��� /�������L

������	���
Current outputs are passive outputs that can be spanned in the 
forward and reverse direction. Example: 0 to 5 or 5 to 0.

):�'���K����������������

���
�����������
�	�����+�����

�����	
�����������
����
�����'�

1. Go to the Calibrate Menu.
2. (	�����
����� to the L

�����
�����menu.
3. P�����£����������Z
���+�
��
4. ������������������	������������G��������
����������	����
�������

control this loop: /��
�	��.
5. P���������Z����������������
���������������

6. (	�����
����� 1 menu to the L

����!���menu.
7. P�����£����������Z
���+�
��
8. Select the minimum and maximum process values for the current 

loop output: ���
�����'.
9. P���������Z����������������
���������������
10. Exit to the View Menu. 

System Start-up: Step 6 (last step)
���#$"�	���	��"��	�������������	�����"��������������������	��%�	��"��	��������	�����"��"��������	��	��	�������	�&�������'	�"�
This concludes the system start-up procedure.

) � & * E L )

Calibrate Menu

Set and save

Set and save

  Loop 1 Source:            
  Chlorine      >Step 2

Loop 1 Rng: ppm
  0.00   5.00  >6

) � & * E L )

) � & * E L )

  Cl In Process
 Calibration:   >

In Proc:  ppm&nA
 2.67  /  103.8

) � & * E L )

Calibrate Menu

�P����������
���
entered here.

ENTERENTER

Step 5

�

�����	�������?���+��	������"��E�
�����
/��	����	
��'�������������������&��	�����
������������?	
���J��
�/��	����	
���
	���

�#�� �����������	������/�������L

�����+�!���(�

���� "��E�
�����/��	����	
�
1. �
Q��
��
�����
��������������(
�������P����;
���������������A�

�����
���
������
�
�
����������������
2. Use this sample to measure the chlorine content with a 

	����������	��P�������Q���;������	��
�
A��*�������������P��Q���
instructions on how to perform this test.

3. Record the test results.

):�'���K���������/��
�	���"��E�
������
��������'�

4. Go to the Calibrate Menu.
5. (	�����
����� 2 menus to the /��"��E�
�����menu.
6. P�����£����������Z
���+�
��
7. Z���������	����������

����
��������
�����������P������������

the edit screen: ���� ��'. The Cl ppm is editable and must 
be at least 0.2 ppm. 

8. P���������Z����������������
���������������
9. Exit to the View Menu.

Calibration is complete for the chlorine sensor.

=��)K�For greater accuracy, it is recommended that 
�����P��������������
��
�������������
�
�������������
averaged together.
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#��� *�����	����!���(�$����	
��

����<$%&����
���
�������	�
����
�
�	������
����
�
�	
��������
�
as switches that respond when the process value moves above or 
������
������
����
����������������	
��������
�����]�����
��I�
G������
������P���������
��P�������������������
��
�����������	����
value. Relay functions, hysteresis and time delay settings are set 
������������]?X*��Z������
�
�	
����������
��������:P�?:H(�
menu.

 L
%�����
	��K
Relay is activated when the measured value is less than
the setpoint.

Hysteresis

Time

Low Setpoint

Process

Relay energized
Relay de-energized

1 4 mg/l

O
ut

pu
t (

pu
ls

es
 p

er
 m

in
ut

e)
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pulses per minute. Example usage would be to control solenoid 
operated dosing pumps.

Z�
����>�����������	�����
����
������������������������;#���@�A�
the output will start pulsing in relation to the process value, the 
maximum pulse endpoint and the programmed pulses/minute. 
The pulse rate will increase as the process value decreases and 
approaches the programmed endpoint. This functionality can be 
used to precisely control the process.

Y� The output will be 0 pulses/minute when the input value is 
greater than 4 mg/l.

Y� The output will be 35 pulses/minute when the input value is 
3 mg/l.

Y� The output will be 100 pulses/minute when the input value is 
1 or less.

The starting point, endpoint and maximum pulse rate are select   -

�������������]?X*��Z������

Hysteresis

Time

High Setpoint

Process
 H	�������
	��K
Relay is activated when the measured value is higher than
the setpoint.

Time

High Limit

Hysteresis

Hysteresis

Low Limit

Process

Window

 D	�+
%K
Relay is off within the window of two setpoints minus the 
hysteresis. Relay is activated when the value is higher or lower 
than the high and low setpoint.

������������	�������
��	���+
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):�'���K�����������(��
���	�����
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%�����
	���
I�������'�
%	������	'��+���(�
I�������
�+����+������
II�����������'�

V� �����������	���	����?�+�	�����
'���	''�+	����(����	?��

1. Go to the Calibrate Menu.
2. (	�����
����� to the !���(���*
+��menu.
3. P�����£����������Z
���+�
��
4. (	�����
����� and choose L
%.
5. P�����Z�����

6. (	�����
����� to the !���(����
�����menu. The default is 
Chlorine which is what we want in this example.

7. (	�����
����� to the !���(����������menu.
8. P�����£����������Z
���+�
��
9. Set the ppm value to trigger the relay:��������'.
10. P�����Z�����

11. (	�����
����� to the !���(���H(��menu.
12. P�����£����������Z
���+�
��
13. (������������������;
�

�����A�������������
��������
���	������������

off only:�������'.
14. P�����Z�����

15. (	�����
����� to the !���(���,���(�menu.
16. P�����£����������Z
���+�
��
17. Set the turn-on delay in seconds for the relay: �������.
18. P�����Z�����
19. Exit to View Mode.

Y� Relay function can be tested in the Options Menu.

) � & * E L )

Calibrate Menu

Set and save

  Relay 1 Mode:            
       Low      >Step 4

Set and save

 Relay 1 Source:
     Chlorine   >6

Set and save

Relay 1 Setpnt:
    1.00 ppm    >9

Set and save

Relay 1 Hys:
    0.30  ppm   >13

Set and save

Relay 1 Delay:
   15.0  secs   >��

) � & * E L )

#��� !���(�����	���

Relay energized
Relay de-energized

1.00

1.30

Time

Cl ppm

Time Delay

Low 
Setpoint
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C&<�"�=!
Y� Remove power before wiring.
Y� Follow instructions carefully to avoid personal injury or 

damage to the electronics.

���� "��������	
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�(������;+(�(A�
���
�
��
�����������
�
www.gfsignet.com.

V� $�������
�	������	���
���
������J����
���������	������������������
Simply pull off the protective boot from the end of the electrode and 
����
����������	���
�����������8���	�����������
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Signet 3-2724-00
;=OW�&&=�O#OA

)�
���G�Z��	���
�

(������%JB$%&J^
Chlorine Electrode
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Y� Refer to the wiring diagram above to connect the 2650 cable to the terminals on the 8630 Chlorine Transmitter.
Y� )���	
����
�����
�
�	������
��������
����������������<$%&�(�����������������
���������;��	�����??A�

/��
�	���,	�	������3L��D	�	��

The electronics are pre-wired from the factory to the transmitter. Refer to the following schematics when replacing the electronics.

18
17
16

Signal Ground

Digital (S3L) data

+5 VDC

White

Red

Black

Shield

�G
Signet 3-2750-7
;=OW�&&=�$L=A

H@�

Gnd

I/O

V+

15
14
13

Signal Ground

Digital (S3L) data

+5 VDC

White

Red

Black

Shield

Chlorine
Signet 3-2650-7
;=OW�&&=�$L&A

H@�
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C&<�"�=!
1 Follow instructions carefully to avoid personal injury or damage to electrode.
B�� P������������
��
�������������
�>
� 
������	����	��8������������������
 b.  Drain below sensor level.
%�� �������	����	
��	���
��������������������
4. Do not alter product construction.

����	
��"8����	����������&'���
'���	��/��
�	���)�����
+�

���� �?��?	�%

)�����
+��!����K�The electrode must match the type and 
range of chlorine concentration to be measured.

$�
%�!���K
�������	���
��������
���
���
����
�
�	����
���8�������
����
past its membrane for accurate measurement.

!����������������������
���
��������)���������X��	Q 
%J#$%&�%WB�;=OW�&&=�$W&AI�����8����
����
�������	��������
�
�������������
��8��������
����
�
�����8����
��������
�	�
����
%&�B#����#O�%$�]PG�;<����=B�[(��@�A��

����
��/
�+	�	
�	��K����
���
���������	���
����"������	��
������������#����������������
���	���
��������
����
�
��
����8�������
������������
���
to generate a stable reading.
(����"�������
��J����	
����"�����
�����	���
��	��
���������
of up to two hours.

���� ������	
�

The maximum allowable operating pressure must be 
�������
��=��
��;=O����A��G���������������������

�
���
the electrode.

The electrode should not be used in water containing 
����
	�
���I�����I����
��	�	�������������
�����������	��
��
cyanuric acid.

Gold cathode

Silver anode

PVDF
membrane

AgCl

e- (loss) e- (gain)
HOCl

current flow

+����P
���H�� Code Chlorine Range Chlorine Type
3-2630-1 159 001 746 &����B�����;��@�A Free chlorine
3-2630-2 159 001 662 &����O�����;��@�A Free chlorine
3-2630-3 159 001 747 &����B&�����;��@�A Free chlorine
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generated at the cathode is proportional to the rate of diffusion through the membrane and the concentration of chlorine in the sample. 
����	����������������	
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�����	��
������
I�
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/��
�	���	��D����
Various forms of chlorine are used to disinfect water. 
Z
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����������
�
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����������������	��	�
����	
�������������
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���
categories used in disinfection are Free Chlorine, Total 
Chlorine and Chlorine Dioxide. Free Chlorine is the sum of 
chlorine gas (Cl2AI�����	��������
	�
�;G:��A�
�
�����	��������
(OCl-A���������G�#�&�
��������������	��
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Free chlorine also combines with naturally occurring or human-introduced nitrogen compounds in the water to form chloramines, also 
Q�����
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species. GF Signet sensors cannot detect or monitor chloramines.  Total chlorine is the sum of free chlorine (Cl2I�G:���
�
�:��-A�
�
�
	������
�	��������;HG2��I�HG��2I�H��3A��

]����	
���:J������
with a non-petroleum 
based, viscous lubricant 
;���
��A�	���
�����������
the system.
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The sensor membrane and internal electrolyte solution must be replaced over the life of the electrode. GF Signet recommends that 
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��
between maintenance of the sensor will be dependent on the actual applications, chlorine level and contaminates in the water.
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Membrane caps carry no warranty.
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8630 transmitter will automatically compensate the free chlorine 
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Figure 1
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necessary for accurate chlorine measurement.
?���������������G��
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compensation.
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Example:
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   Automatic pH compensation recommended
   in ranges within shaded area
=

Figure 2

=��)K�The membrane cap must be replaced every time the electrolyte is changed.
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The use of this product assumes that operators are trained and are familiar with this type of device. 
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����Q�����
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���	�
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Operators MUST follow all necessary safety procedures.

"���	�����'
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��K
=�� �������������
�
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2. Drain the system to below sensor level.
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solvents.
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�����������	�����'�����������+�E������������	
���	
��

109 mm
(4.3 in.)

25.4 mm
(1.0 in.)

Threads:
¾ in. NPT

44.45 mm
(1.75 in.)

*�:����'��������7E��������!��	��
Operating Temperature Range*: 
� �=&����<O�¢��;=#����=<O�¢)A
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�����P��������*
���>
� �=&����$O�¢��;=#����=#W�¢)AI
� &����$�W��
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� $O����<O�¢��;=#W����=<O�¢)AI
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C&<�"�=!
1. Use appropriate eye, face, hand, body and/or respiratory protection 

when using chemicals or solvents.
2. P������������
��
�������������
�>
 a.  �������������
�
�������������
 b.  Drain below sensor level.
3. �������	����	
��	���
��������������������
4. Do not alter product construction.
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non-petroleum based, 
���	���������	
���;���
��A�
compatible with the 
system.
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pH 4 pH 7
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1. Rinse the sensor off in the rinse water cup. Gently pat dry with a soft, dry cloth or tissue. D���	��K�,
��
�����������	����%�����+�	� 
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3. Follow the instrument’s instructions regarding buffer recognition.
4. Rinse the sensor with water. D���	��K�,
��
�����������	����%�����+�	��	��
�������II����
���	
�����	��%	���+	����������
���	
����+�

'�(��������������II���?������
5. Dry the sensor gently by patting it with a dry, clean cloth or tissue.
$�� P�
	����������������
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�����������������;�G�#��� 

�G�=&A��������	��
�������������
������
����
������������	
���G��
�����������
application.
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8. Follow the instructions in the instrument manual regarding buffer recognition.
9. Rinse the sensor with water. D���	��K�,
��
�����������	����%�����+�	��	��
�

������II����
���	
�����	��%	���+	����������
���	
����+�'�(������������
��II���?������

10. Dry the sensor gently by patting it with a dry, clean cloth or tissue.
==�� ?������	
����
������
����		������I�����������������
	Q���J������?������
��������		������I�	��
�������������
�
���	
����
����?������

sensor cannot be calibrated, the electrode may need to be replaced.
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���G������I�����������������������
�����������
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and must not be diluted by rinse water from previous calibrations.
 Note: Use fresh buffer solutions for best results.
B�� �
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�������
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�����������������	���
������������
	������������������
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����������
������������
����������������������������
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���������������������������������
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of the sensors and the calibration solutions.
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	Q����������������\�
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�
���
O�� (��������	���
�������G�#������������������������
6. Calibrate sensors on a regular basis.
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�
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calibrate outside of acceptable limits, the electrode is spent and must be discarded.
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�����G��
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����
�����
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� �G�L>�G���>�L�<��G� �JO&���\�]��>�$�B��G� �O&���
� �G�#>�G���>�#�<��G� �BBL���\�]��>�%�B��G� �=BL���
� �G�=&>�G���>�=&�<��G� �JBBL���\�]��>�W�B��G� �J=BL���

�������K
Z��	���
����������������
��������������G������������BO�¢��
������������	
�����������OW�=$���������G�

���� �)�����
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Y� The mV output from the electrode is created by the interaction 

����������	���
��
�
�����8��
���������	���
��	���
����
�����
that depletes over time, so the instrument must be readjusted 
periodically to maintain system accuracy. The need for 
recalibration varies with each application, but the life of the 
electrode is usually consistent.

Y� Keep a maintenance log to establish a depletion trend in new 
systems.

Y� �������	
����
��������
����J���������	�
�����(��������������G�
���������������������
��
����	��	
���������������������

Y� �G������������������	
��������
�����	
����
������������
������
sensor within a day provided that the solutions are protected 
from debris and are not diluted by rinse water from the 
calibration procedure.

Y� Use clean water to rinse buffer solutions from the electrode.
Y� Dispose of all buffer solutions at the end of the day.
Y� ?�������G�����������������	
����
����������
		���
����������I�	��
��

�������	���
��
�
���	
����
����?������	
����
����������������
���
outside of acceptable limits, the sensor is depleted and must be 
discarded.

Y� Follow the guidelines of local waste disposal regulations when 
discarding buffer solutions and spent electrodes.

���
���	����'8�8������������/
�G mV

2 +295.8 mV

3 +236.64 mV

4 +177.48 mV

5 +118.32 mV

6 +59.16 mV

7 0 mV

8 -59.16 mV

9 -118.32 mV

10 -177.48 mV

11 -236.64 mV

12 -295.8 mV
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The electrode date code indicates the manufacturing date of the electrode. Electrodes should be put into service as soon as possible 
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*�������������	��������	��
���?������������
is not desired, it may be removed from the 
system.

Flow Regulator

���?	�	�������$�
%�!������
����+�$	����

Figure 2

Figure 1
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of the wiring enclosure if the sensor suddenly releases.
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 1.1 Cleaning

Step 1. Keep the system powered on.

Step 2. Disable the relays and any output loops.

Step 3.� ��������������
����8���

Step 4.� *���������������������������8���	����

=��)K��?�����������	���
��������������������	�����	������������������

Step 5.� ?���
�������������	
������������������������������
	��� �
 the tips of the removed sensors in a cup of sample   
� �
��������������
�������
���������	��
���������8���	������
 
              ~������������
���	���%�����+���������
��������	;�+.

Step 6.� *����������8���	��������������
�������������������
� Q�����
������;)������=A�
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�
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��8"���&����+	:

=��)K It is recommended that an anti-seizing compound appropriate for the 
�������������	�"�	���"���$���	��	���	�����$������	�
�
��	���

D&!="=BK��������
��
������������8���
regulator. There are no user serviceable 
parts inside.
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1

2

3

6
5

4

H���:J����
cross section

:�
�8
�����
�:J����
cross section

;*���
	�A

?�
���
�
��:J�������������
X����
��������������������������������
��
��������

)���8�������������
�
 Straight cut

������	���:J����
)���8�������������
�

������	���:J����
)���8�������������
�

Straight cut

Butt ends together

Y� ������
������������8���	�������
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���������
�
���������
�:J��������
���������8��������
�����
*�������������������
������������������	�
��:J������������
instructions. Butt all O-ring joints together so there is no gap.

Y� *����������:J������
������8���	����
��
���������X��������
O-rings and all sealing grooves should be examined for 
cleanliness.

Y� !����
�������
	���	
�������������
�����I�����J�����	���������������
good sealing.

Y� The cross section of the O-rings should be round and smooth. 
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I�������
������������
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Tighten the nut just enough to hold 
�������	Q����������
�
�Q��������
O-rings in place.

6

Tighten the bolts in three passes to 
���	��	
�����

#
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%�/����&���'��(

D&!="=B��
,
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5

?���
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and nuts.

�

12

3

6

5

�
�P���
#���='�

����L��"��
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4
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����	����������

?���
�������
�������
����������
regulator and the two round 
:J���������������8���	����

1

?���
������������:J�����
segments.

2

?����������	��������������������
���	Q�

3

4

������
�
���
	�������
	Q����	Q�
��������8���	��������	Q�������
sure that the O-rings are seated 
correctly.

9
?���
�������8���	������������
�����
(	����������������������������������
Do not use tools on the thumb nuts.

=��)K It is recommended that an anti-seizing compound appropriate for 
��	��������������	�"�	���"���$���	��	���	�����$������	�
�
��	���
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Store electrode between  -10 to 60 ºC
;J#����=#&�¨)A�
��
����
���������
������
��

����������	��
�WO�����������
���
concerns when storing the electrode is 
�����
���
���
�
�����
�
�������������
extremely cold environments.

The electrode is not recyclable. Dispose of properly according to local, state and federal guidelines. 
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������	'� &��	
�

©�L��
�� (��������	���
���������8���	����������
��������������������
���
dehydration.

��L��
��

Store electrode with the protective cover for the membrane 
attached; or immerse the end of the electrode in a small container 
����
�������Q�������������
��������������������������	���	
��
	���
	�������������]�	���
�����������	���
������

��=������

Unscrew the membrane cap and store it fully immersed in tap 
water. Remove the electrolyte from the electrode by holding it over 

�	���
�����
�
���
Q��������������
���������
�
����
����������
�
��
the solution.

DO NOT
FREEZE
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=��)K�The membrane cap must be replaced every time the electrolyte is changed.

1. Remove the membrane cap from the front of the sensor.
B�� ��������������������
��
����
�
���
Q��������������������������������������

internal electrolyte.
3. Fill supplied syringe with electrolyte solution.
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electrolyte solution. The electrode holds approximately 14 milliliters of solution. 
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To avoid damage and contamination, do not touch the white membrane surface on 
the membrane cap.
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can also be used.
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Y� Keep the glass surface wet at all times.
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 3.2 Cleaning
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����������	��	�	�������������������������

E�
���' E
��	����/���� !�'�+	��

H���
����8��

?��������������������=��
��;=O����A ���	Q�����	������������*�����������
����������������
is < 1 bar/15 psi

�
�
��
�8��������
��� *���
	��8��������
���

������
������ ���
��������������������������������
�������������
������������������=��
��;=O����A

]����
����8��

������
������ ���
�������

?�����	������������������� ?�	��
������������������������	��	
���������������8���
regulator

�
�
��
�8��������
��� ?����	���������
	�

Z�	�������8��
Excessive pressure over 8 bar 
;=B&����A

Ensure inlet pressure does not exceed 
<��
��;=B&����A

�
�
��
�8��������
��� *���
	��8��������
���

)����	������
Q�

?�	����	��
������� ?����	�I�	��
�I�
�
���
�������
]���������� ��������������;<�=�H�I�LB�]�J?��+
�A
Defective or missing O-rings Replace O-rings
Damaged sealing surfaces *���
	��8���	���

]�
Q��
����
�������
Damaged sensor O-ring ?����	���������
	��:J����
�
�
��
�8���	��� ?����	��8���	���

!
������
Q����������������������

Drain valve closed or plugged ?����	�
G����	����	������
����
	Q�
�
� Connect water source correctly

:������
�
�������������8���	��� *�����
�
��������������8���	����
�
������
����
atmosphere

���
������������8���	���
]���	��������	��	����
���������
���

]�	
���8���	����
�
������������
Exposure to light

Z�	���������
��������������8���
cell accumulating on sensors

!
��������	��	���
�����������
���	Q��
��������	�!
��������	������
���
��
������

dissolved gasses

Transmitter does not turn on 

H�����������������
��	��	�������
Q�������
switched off ?����	��������
�
��������	����	�����

]����������	����	�������	����	����� ���	Q�	����	�����
Open loop wiring or missing jumper 
��������������
��=�;]����=A��������
���������	�������������
�����	Q

Replace jumper wire to terminal 1 or connect a loop 
device if the jumper wire to terminal 1 is removed

Chlorine reading too high Breached membrane *���
	�������
���
�
�������������

Chlorine reading too low

]���8����
�� ���	Q�����	����������
Filter clogged ���
�����������

Sensor conditioning not long enough ��������������������	��
����������#������
;(���B$%&���������
��
������
��
���A

Sensor output drifts
�
��
����8����
�� ���	Q�8����
��
������
������ ���
�����������
����
���
��
������������� ��
�������	��������������������

���������Z��	���
������������������;����B$%&JB����	���
���
��
�A
��
�������������������������;����<$%&J%���
����������
��
�A
�G�Z��	���
������������������;����BLB#����	���
���
��
�A
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���� ��
������

�	�����#����/��
�	��������'	����

(����
���
	�����	
��	
�����������
�������	����	����

������������������������	��	Q����������������
��������
���������
�
����������
��������
installed correctly. The list below outlines possible causes and remedies.

Transmitter Troubleshooting
P������ P���������
��� Remedies

Transmitter does not turn on.

?�	����	���������
H�������������
����������
������
���������
Blown fuse.
Bad wire connections or splices.

���	Q�������I��������������
�
��������
connections.

�����
���	������������

�Q��������
��� Contrast set incorrectly or ambient 
temperature is too high. �
�����	����
������:�������+����

]����
	Q�����I����
���
�
���������
��
�������Q� H���������������
����������
���=�
�
�B� ��
�����������"���������������������
���=I�

2, 3 and 4.

?�	����	��������
�������

���� Faulty chlorine sensor.
Bad sensor connection. ���	Q�	����	�������������
	���������

Display or Current output is erratic.
Electrical noise interfering with the 
measurement.
Sensor malfunction.

Ensure system is properly grounded.
See Sensor Troubleshooting.

:��������������������������	���
�����
placed in non-chlorinated water.

Electrode not properly conditioned.
H����������������������������
���������
Calibration incorrect.

Condition new sensor for 4 hours. Cap 
����
	������������	�������������>�B�������
P�������������
��������
Replace sensor.

#����B&����������������	����	��
#����B&������������	
��
��
���
��]����
device.
]����
���	����������	
��
��
���
���������

Re-span loop device to match sensor.

���������(����������������������;����B$%&���������
��
�A

?�	����	����

����

Sensor conditioning time too short. Run for 4 hours before calibrating.
Membrane cap damaged or contaminated. Clean or replace cap.
?���������	��������
����	���
���
���� See Specifcations data. 
]���8����
��� ���	Q�8���
��������������������
��� ?���
���8���	���������	
������������
�
��8���
�G������
�����Q�����
����
;(���(��	��	
������

�
A�� ���	Q��G�

]������������	������������������ Fill sensor with electrolyte.
Membrane cap loose. ?����	�@��������;
���������������A�
Only combined chlorine present when 
measuring free chlorine. �
��

���������P�������

(�����������
Q�������
�	���
	�������
electronics. ?����	��
�
���	����	��

Defective sensor. Replace.

H���G�	������
��������������
� +
��
�����������G��
�������:����������
	
����
����G��������

Cl sensor not calibrated. Calibrate Cl sensor.
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����<$%&��������
�������
�������J����
�
�������������������
���	
��
���
����
�����������������	��	����
�	��>
Y� User input value is out of range 
Y� P�������	���	
��	����	����
Y� Sensor is not connected or detected
Y� Temperature error
Y� ?�	����	��������������	�������������:�������+���
Y� ����	
����
������������
�������	�������������������	
����
������G����	��������

)��
��*������� E�
���' E
��	����/���� !�'�+	��

Sens Data Error Cl sensor data memory error. Cl sensor is not connected.
Damaged sensor.

���	Q������������������
�
�
connection.
P�������
�N)��
�H���(�����N����
recycle power afterward.

 CHK Cl PREAMP Cl preamp is not detected.
Cl preamp is not connected. 
!������������
Damaged preamp.

���	Q����
���
�
���
���������
wiring.
P�������
�N)��
�H���(�����N����
recycle power afterward.

 CHK pH PREAMP �G����
����������
���	��
�
�G����
����������	����	��
��
!������������
Damaged preamp.

���	Q����
���
�
���
���������
wiring.
P�������
�N)��
�H���(�����N����
recycle power afterward.

 CHK Cl SENSOR Cl sensor is not detected. Cl sensor not connected. 
Damaged sensor. ���	Q��������	����	�����

 CHK pH SENSOR �G���������������
���	��
� �G���������������	����	��
�
Damaged sensor. ���	Q��������	����	�����

  Out Of Range
  CHECK SENSOR �G�	
����
����������� �G��
�����
�����������
���� Enter proper values during 

calibration.

Standard Too Close
 To Slope!

�G���
�

�
�	
����
��������������
too close to slope point.

!�����

�
����������
���G�
buffer solution used has value 
too close to standard point.

Re-enter correct data. 
Use proper buffer solution at 
��
���B��G�������
�
��������������
buffer solution.

Slope Too Close
 To Standard!

�G�������	
����
������������������
close to standard point.

!�����

�
����������
���G�
buffer solution used has value 
too close to standard point.

Re-enter correct data. 
Use proper buffer solution at 
��
���B��G�������
�
��������
standard buffer solution.

Signal Too Close 
To Other Cal Pt

��������
������������������?�J
process calibration is too close 
�������¡�����
��P������

�������������������
�����?�J
process calibration is too close 
to Zero Cal. These two points 
��������=����
�
���

Use proper solution at least 
=����
�
���

Cl Value Must Be 
   > = 0.2 ppm

��������
����������
�
������?�J
process calibration is too small.

!�����

�
����������
������
value entered must be at least 
&�B�����;��@�A�

Re-enter correct value.

����� �����'	�����)��
��*�������
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������'	�����)��
��*�����������
��	���+

=��)K��!��������
��������������=�(���������	����	��
�����������
��I�
���������	�	����������"����
�������������������������������
�
N)��
�H���(�����N���
�������:������+����

Signal Too High
Must Be =< 10 nA

The signal level during Zero 
calibration is too high. Signal 
���������"�
������������
��
=&����

��������������������
������
��
The solution used has too much 
chlorine.

!
����������������
�����
�����
���	Q����������������������
��
����	�����������������	�������������
����;��@�A�

pH Too High
Must be =< 9 �G��
����������������

�������?�JP��	����	
����
�����
�����G��
����������������
�
�
���������������
������"�
�����W�

���	Q��G�

pH Too Low
Must be >= 4 �G��
���������������

�������?�J���	����	
����
���������
�G��
���������������
�
���������
���
������
������"�
�����#�

���	Q��G�

FCl= – – – – – –
CHK pH SENSOR �G���������������
���	��
�

�G���������������	����	��
�
!������������
�
�
��
��G��������

���	Q��G��������	����	������
���	�
�����G����������+
��
�����
Options Menu.

FCl= – – – – – –
CHK pH PREAMP �G����
����������
���	��
�

�G����
����������	����	��
�
!������������
Damaged preamp.

���	Q��G����
����������
P�������
�N)��
�H���(�����N����
recycle power afterward.

FCl= WRONG SENSOR !���������������
���	��
�

Different type of sensor is 
connected.
!������������������������	��
�
under Option Menu.

Use correct sensor type.
P�������
�N)��
�H���(�����N����
recycle power afterward.
Select correct sensor type under 
Option Menu.
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E�
���' E
��	����/����� !�'�+	��

Sensor cannot be calibrated.
:������������������
���P�������
;��������
���A�

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

?���������	�������	���
���
��� (���(��	��	
������

�

Membrane cap damaged Replace cap and recondition
�P��	����	
����

 Use fresh reagents
�G������
��������Q�����
��� (���(��	��	
������

�


Sensor cannot be calibrated.
:�����������������
���P�������

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

Chlorine content too low �P���
���������������
������
��&�O��������
calibrate

]���8����
�� ���	Q�����
Q�������8����
����������	����

������������������	���
�������
�� ?����	������
������
���������������������+�����
��
an angle

]������������	��������������	���
� Fill electrode with electrolyte
Organic chlorination agents present in water (���(��	��	
������

�

Surfactants in water Remove surfactants and replace cap
Membrane cap coated Clean or replace membrane cap
Membrane cap loose Tighten or replace membrane cap
�G������
�����Q�����
���� (���(��	��	
������

�


Sensor output very low

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

Chlorine content too low �

�	������������
��

��
:��������
�	�����������������H�������	������� ���	Q�����	����
����������
�������
����P������
Z��	���
�������
Q�������
�	���
	�������
electronics ?����	��
�
���	����	�

Unstable output from sensor

������������������	���
�������
�� ?����	������
������
���������������������+�����
��
an angle

Membrane damaged Replace membrane. Condition sensor for at least 
2 hours and recalibrate.

Z��	���
�������
Q�������
�	���
	�������
electronics ?����	��
�
���	����	�

H��J��������������
���	Q�%JB$O&�Z��	�����	��	����	�����������	���
��
;����%JB$O&��
��
������������	�����A��+
Q�������
	����	������
���
�������	Q���������������Q��

Transmitter error messages related to calibration are detailed in the Signet 8630 Chlorine Transmitter operation manual.

���� ��
������

�	����������&'���
'���	��/��
�	���)�����
+��
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��	����/���� !�'�+	��

������	����������	
����
��������	�
���I�
the output values are inaccurate.

?�����	����������
�����
��������	���
��
��
�����
�����
������	
����
�����

Recalibrate, verify that test solutions are 
at room temperature and wait at least 30 
seconds after placing electrode in solution.

��
�������������������������;����<$%&J%���
����������
��
�A
�G�Z��	���
������������������;����BLB#����	���
���
��
�A
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z�+
����
��(
������
�
�(������;+(�(A�
���
�
��
�����������
���������������	���

�#�� ����	
���	
����������/��
�	���&���(;��

)�?	�
�'������!�P�	��'����
��
�������'��������K

&����$O�¢��;%B����=#W�¢)A
������	�����'��������K

&����#O�¢��;%B����==%�¢)A
!����	?��H�'	+	�(K

&����WO�
*�:	'�'�&��	��+�K

B&&&���;$O$B���A
)���
����K

Y� HZ+��#^�;�������������������
�
����
��
A

����+��+����+�&���
?���
CE
[]

����
�*�G(�;�������������������	�������
��
���A

��	��	���D�	���
=&�Q��;BB����A

B������
/
'���	��������
��K

Signet 3-2630-1 Chlorine Sensor 0-2 ppm
Signet 3-2630-2 Chlorine Sensor 0-5 ppm
Signet 3-2630-3 Chlorine Sensor 0-20 ppm
(������%JBLB#J&&�)�
���G�Z��	���
�

*����	���K
P
���>�X�
	Q��	����	
)��������>��	����	
!������Z�	������>�P���	
����
��

D����+�*����	���K
�	����	�;8���	���I���
	��������A
P���	
����
���;8��������
�����������A
Stainless steel (strainer, e-clip, regulator spring, 
8�
�A
P�������������;�
����I������A
ZP�+I�)K+�;8���	����:J�����I�
�
���
��A
P��I�P��)I�)P+�;������������	���
�A
PP(I���
��I�[G+!I�PZI�)P+�;�G����	���
�A
P�)Z�;��
������
�������
����I������
�
�����A
P������������;����A

E��I
�'����
�(���'�"�����E��������!��	��K

=����<��
��;=O����=B&����A
E��������!������
�K

«�&�$W��
��;=&����A��
��
����������
����
��������8���
and pressure

Electrical
&/�"�����������+��+�/
�
�����	
�K

=&&����B#&����������
��;<O����B$#����AI� 
O&����$&�G��;#L����$%�G�AI�&�=L���
��=&&����

,/�"����������	
����/
�
�����	
�:
=B����B#������=&�������
��
I�=&�!I�BO&�����
�

=��)K
� P�����(������L%&&J&&B#�;=OW�&&=�$W%A�;��
�

�
������������A 
� � W&�J�B$#��I�&�%%$�J�&�=$<��I�&�%=$���¬�=&&��I�O&����$&�G�

� :�����
���������������L%&&JLOB#�;=OW�&&&�$<LA
�� � =&&JB#&����I�&�%<�J�&�B#��I�O&J$&�G�
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"���������	
���	
��K
One Digital (S3]A������������)������������I�
One Digital (S3]A�������������G�������

�����������	
���	
��K
��������]����;B������������
�
A

#����B&���I�����
��
I�

����
������
�I�
reversible with minimum and maximum 
endpoint adjustment.

 ���������������	�����������������
�����
�������
 Update Rate: 300 ms

+
��]��������

�	�>
O&�­��
���¬�=B��
%BO�­��
���¬�=<��
$&&�­��
���¬�B#��

Relay Outputs:
B���	�
��	
��(P���	���
	��������

����
����
�����������
�
������
��
����G���I�]��I�:��I�
P��������!��
����
�����
Maximum voltage rating:

O���¬�%&����
O���¬�BO&����I�������������



May be disabled if not used
�����
��
�>�P����
��
���������&����$#&&��

�)�?	�
�'������!�P�	��'����
������	�����'��������K

JBO����=B&�¢��;J=%����B#<�¢)A���
�������������
��
�������'��������K

J=O����<&�¢��;O����=L$�¢)A
!����	?��H�'	+	�(K

&����WO�I����J	��
������
*�:	'�'�&��	��+�K

B&&&���;$O$B���A
)���
����K

HZ+��#^
����+��+����+�&���
?���

CE
[]
+
���
	����
���
���?(:�W&&=�
�
�?(:�=#&&=
Y� ���������
�*�G(�;�������������������	�������
��
���A

B������
/
'���	��������
��K

Signet 3-2630-1 Free Chlorine Sensor 0-2 ppm
Signet 3-2630-2 Free Chlorine Sensor 0-5 ppm
Signet 3-2630-3 Free Chlorine Sensor 0-20 ppm
(������%JBLB#J&&�)�
���G�(�����

/
'���	����)�����
�	��
(������%JB$O&JL������������	�Z��	�����	�
(������%JBLO&JL��G�(������Electronics

*����	���K
Case: PX�
P
����	
����
�Q��>�H�������
!��
��>�P��������
��J	�
��
�����	
����
��
Keypad: Silicone rubber

,	����(K
]��>�X
	Q����alphanumeric 2 x 16 dot matrix
Keypad: Silicone rubber
Display update rate: 1 second
Contrast: User selected, 5 levels
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3-2630-1: Free Cl: 0 to 2 ppm
3-2630-2: Free Cl: 0 to 5 ppm
3-2630-3: Free Cl: 0 to 20 ppm
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Signet 3-3610-1
Signet 3-3610-2
Signet 3-4630.392
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Counter reference electrode: Silver halide
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